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 Note!

 Before using this information and the product it supports, be sure to

read the general information under “Notices” on page v.

Second Edition (March 1993)

This edition applies to Version 1.1 of IBM WorkFrame/2 (61G1177, 61G1427) and to

all subsequent releases until otherwise indicated in new editions. Make sure you are

using the correct edition for the level of the product.

Order publications through your IBM representative or the IBM branch office serving

your locality. Publications are not stocked at the address given below.

A form for readers’ comments is provided at the back of this publication. If the form

has been removed, address your comments to:

IBM Canada Ltd. Laboratory

Information Development

21/986/844/TOR

844 Don Mills Road

North York, Ontario, Canada. M3C 1V7

You can also send your comments by facsimile to (416) 448-6057 addressed to the

attention of the RCF Coordinator. If you have access to Internet, you can send your

comments electronically to torrcf@vnet.ibm.com; IBMLink, to toribm(torrcf);

IBM/PROFS, to torolab4(torrcf); IBMMAIL, to ibmmail(caibmwt9)

If you choose to respond through Internet, please include either your entire Internet

network address, or a postal address.

When you send information to IBM, you grant IBM a nonexclusive right to use or

distribute the information in any way it believes appropriate without incurring any

obligation to you.

 Copyright International Business Machines Corporation 1992, 1993. All rights

reserved.

Note to U.S. Government Users — Documentation related to restricted rights — Use,

duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule

Contract with IBM Corp.

IBM is a registered trademark of International Business Machines Corporation,

Armonk, N.Y.
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 Notices

References in this publication to IBM products, programs, or services

do not imply that IBM intends to make these available in all countries

in which IBM operates. Any reference to an IBM licensed program in

this publication is not intended to state or imply that only IBM’s

licensed program may be used. Any functionally equivalent product,

program, or service that does not infringe any of IBM's intellectual

property rights may be used instead of the IBM product, program, or

service. Evaluation and verification of operation in conjunction with

other products, except those expressly designated by IBM, is the

user's responsibility.

IBM may have patents or pending patent applications covering

subject matter in this document. The furnishing of this document

does not give you any license to these patents. You can send

license inquiries, in writing, to the IBM Director of Commercial

Relations, IBM Corporation, Purchase, NY 10577.

Trademarks and Service Marks

The following terms used in this publication are trademarks or

service marks of IBM Corporation in the United States or other

countries. They are denoted by an asterisk (*) when they first

appear in the text.

 IBM

 OS/2

 Presentation Manager

 WorkFrame/2.
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 Introduction

The IBM* WorkFrame/2* (referred to in this document as

WorkFrame/2) product offers a unique application development

environment that you can easily tailor to your own personal needs.

In addition to providing a number of utilities, including make file and

library creation, the WorkFrame/2 product allows you to integrate

both 16- and 32-bit OS/2* tools. You can use language profiles to

specify the compiler, linker, debugger, and make utility you want to

use for each of your programs. You can also set compile, link,

debug, and run options in advance and save them to use every time

you create a program.

The WorkFrame/2 product takes full advantage of the OS/2 platform

to create a customizable and user-friendly graphical interface that

makes building applications simple and straightforward.

Although the WorkFrame/2 interface is designed to allow you to use

any tools you choose, IBM also offers two additional products that

integrate into the WorkFrame/2 environment.

� The IBM Developer’s Toolkit (10G3355, 10G4335, 10G3356)

provides development tools such as a linker, a make utility, and

other programming aids.

� The IBM C/C++ Tools product (61G1176, 61G1426), a 32-bit

SAA C and C++ compiler, debugger, browser, and execution

analyzer. Includes a language profile and sample projects

designed specifically for use with the WorkFrame/2 product.

 Documentation

WorkFrame/2 documentation is provided online in two different

forms. The central concepts, along with information on the

command-line interface for the LIB and ADDTOOL utilities, are

included in the online book DDE3WF.INF. To open this book, type

 view DDE3WF.INF

 Copyright IBM Corp. 1992, 1993  1



  

 

Documentation is also available in the form of context-sensitive help.

You can ask for help on any menu choice, window, or field to

discover how to use that particular item.

Additional Technical Information:  While the WorkFrame/2 default

profile DLL should be sufficient for most development needs,

language vendors and developers creating options dialogs

will want to create their own DLLs. If you will be creating

your own language DLLs or tools that need to be more

closely integrated with the WorkFrame/2 interface, you will

need additional technical information about the WorkFrame/2

programming interfaces.

Please address requests for information about the

WorkFrame/2 interfaces to:

IBM Canada Ltd. Laboratory

OS/2 Products, Department 171

22/171/844/TOR

844 Don Mills Road

North York, Ontario, Canada. M3C 1V7
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Installing the WorkFrame/2 Product

This section will guide you through the WorkFrame/2 installation

program. Online help is available throughout the program for each

option, field, and pushbutton. You can get help from the Help

pull-down menu, or by making the field or pushbutton active and

pressing F1. For general information about the currently active

window, press F2.

The installation program creates the necessary subdirectories for

you, updates your CONFIG.SYS file if you choose, and creates a

folder for the WorkFrame/2 product on the Desktop.

The WorkFrame/2 package includes 2 diskettes. The WorkFrame/2

files require approximately 2.0 MB of disk space.

 LAN Installation

You can install the WorkFrame/2 product on a local area network

(LAN), either to serve as a base for other installations or to be

shared by multiple users.

If you are installing the WorkFrame/2 files on a LAN server to be

used as a base for future installations:

1. Insert the WorkFrame/2 diskette into drive A.

2. From an OS/2 window or full screen, change the current drive to

drive A.

3. From the server machine, use xcopy to copy the WorkFrame/2

diskette to a target directory on the server. The command

syntax is:

xcopy a:\\.\ target-directory /s

The WorkFrame/2 directory and file structure is copied to the

server in the target-directory specified. The installation

program is also copied to this directory.

 Copyright IBM Corp. 1992, 1993  3



  

 

To then install the WorkFrame/2 product on a client machine, follow

the normal installation procedure, beginning at step 3 on page 4.

If you will be sharing the WorkFrame/2 product across a LAN, follow

the normal installation procedure using a target directory on the LAN.

Each user sharing the files must then set up the WorkFrame/2

environment on the client machine with the Add User utility,

described on page 5.

 Installation Procedure

1. Insert the WorkFrame/2 diskette into drive A.

2. From an OS/2 window or full screen, change the current drive to

drive A. If you are installing from a LAN, change to the

target-directory on the server machine.

3. At the command prompt, type

 install

and press Enter. If you have not disabled the logo display from

the operating system, the IBM logo appears. Click on the OK

button or press Enter to proceed.

A dialog box appears with the installation options. The

READ.ME file is displayed in the main installation window. Read

this file for the latest information about the WorkFrame/2 product.

4. Specify the drive and directory where you want the WorkFrame/2

to be installed, and whether you want the program to update

your CONFIG.SYS file. The IBM-supplied defaults specify

IBMWF on your boot drive as the target installation directory, and

do not update your CONFIG.SYS file.

Notes

� If you change the target directory, substitute your directory

name wherever C:\IBMWF appears in this document.

� If you do not have the installation program modify your

CONFIG.SYS file, you must add the DLL subdirectory to

your LIBPATH statement. For the full path of this

subdirectory, see “WorkFrame/2 File Structure” on page 19.
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Commands to set the other environment variables are

included in the WFENV.CMD file that is created by the

installation program.

5. When you have set your options, click on OK or press Enter.

The program prompts you for the proper diskettes during the

installation. A window shows you the status of the installation

program, including which files are being installed and the

percentage of the total bytes that has been installed.

6. When the installation is complete, a message box appears. Click

on OK to return to the main installation window, then select

Close from the system menu to end the installation program.

7. Reboot your system if you or the program modified your

CONFIG.SYS file.

Backup Files:  Before it modifies your CONFIG.SYS file, the

installation program first creates a backup copy with the

name CONFIG.BAK. If this file already exists, a dialog box

appears. You can overwrite the existing backup file, or type

a new file name. Then click on OK or press Enter.

If you do not want to create a backup file, click on Cancel to

close the dialog box and continue with the installation.

If you reinstall the WorkFrame/2 product, the program also

backs up the files WFENV.CMD and IBMWF.INI to the files

WFENV.BAK and IBMWF.BAK.

Add User Utility

The Add User utility is an interactive program that creates the

necessary WorkFrame/2 environment for users who are sharing the

WorkFrame/2 product from a LAN server.

You can also use the Add User utility if you are using multiple boot

drives and want to invoke the WorkFrame/2 product from a boot

drive other than the one you installed the files on. To do this, the

WorkFrame/2 files must be on a partition that is accessible by the

other boot drives.

  Installing the WorkFrame/2 Product 5



  

 

You do not need to choose all the options the first time you use the

program. You can use this utility again at any time to update or

change your WorkFrame/2 environment.

Online help is available throughout the program for each option, field,

and pushbutton.

Add User Procedure

1. From the client machine, access the IBMWF\BIN directory on the

LAN server (or on the drive where it was installed, if you are

using multiple boot drives).

2. From the IBMWF\BIN directory, type

 adduser

and press Enter. If you have not disabled the logo display from

the operating system, the IBM logo appears. Click on the OK

button or press Enter to proceed. A dialog box appears

displaying the Add User options.

3. Specify the source drive and directory for the WorkFrame/2 files,

and the target drive and directory to be used on the client

machine, and select the options you want.

The IBM-supplied defaults copy the WorkFrame/2 language

profiles, project control files, and bitmaps from the source path

indicated on the LAN to the IBMWF directory on the boot drive of

the client machine. They also create a user profile (IBMWF.INI)

that saves information about how you customize the

WorkFrame/2 interface, a command file to start the WorkFrame/2

product, and a WorkFrame/2 folder on the Desktop.

If you do not select any of the options, the Add User utility will

only update your OS2.INI file to point to the WorkFrame/2

installation directory.

Notes:

� If you are using the WorkFrame/2 product from a LAN

server, you must have at least a user profile (IBMWF.INI file)

to start the WorkFrame/2 product, and the language profiles

to perform any actions (such as compile and link).
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� If you are running the WorkFrame/2 product from multiple

boot drives, you need only update your OS2.INI file.

� If you do not have the program modify your CONFIG.SYS

file, you must add the DLL subdirectory to your LIBPATH

statement. For the full path of the DLL subdirectory, see

“WorkFrame/2 File Structure” on page 19.

4. When you have chosen the options that you want, click on OK.

A window appears and shows you the status of the Add User

program, including which files are being copied or created and

the percentage of the total bytes that have been copied (if

applicable).

5. When the environment has been successfully established, a

message box appears. Click on OK to return to the main

installation window, and then select Close from the system menu

to end the Add User program.

6. Reboot your system if you or the program modified your

CONFIG.SYS file.

Backup Files:  Like the installation program, before it modifies your

CONFIG.SYS file, the Add User program first creates a

backup copy with the name CONFIG.BAK. If this file already

exists, a dialog box appears. You can overwrite the existing

file, or type a new file name. Then click on OK or press

Enter.

If you do not want to create a backup file, click on Cancel to

close the dialog box and continue with the Add User

program.

If you run the Add User program again, the program also

backs up the files WFENV.CMD and IBMWF.INI to the files

WFENV.BAK and IBMWF.BAK.

  Installing the WorkFrame/2 Product 7



  

 

 WFENV.CMD File

The installation and Add User programs both create a command file,

WFENV.CMD. This file contains commands to set the necessary

environment variables for the WorkFrame/2 product and also invokes

the WorkFrame/2 product.

If you use the installation or Add User defaults, WFENV.CMD

contains the following statements:

 SET PATH=C:\IBMWF\BIN;%PATH%
 SET HELP=C:\IBMWF\HELP;%HELP%
 SET BOOKSHELF=C:\IBMWF\HELP;%BOOKSHELF%
 START WF.EXE

If the installation or Add User program updated your CONFIG.SYS

file, or if you change the environment variables yourself to reflect the

statements in WFENV.CMD, you can invoke the WorkFrame/2

product using either WFENV.CMD or WF.EXE.
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 Getting Started

To start the WorkFrame/2 product, type

 wfenv

on an OS/2 command line from the BIN directory under the target

installation directory, or open the WorkFrame/2 folder on the Desktop

and click on the WorkFrame/2 program icon.

The WorkFrame/2 main window appears, with a menu bar and two

smaller windows.

Customizing the Environment

You can change the WorkFrame/2 appearance to fit your own needs.

Using your mouse (or your keyboard), you can change the size,

shape, and position of the main title and menu bar and the

background. (See “Hints on Using Your Mouse” on page 10 for

more information.) You can also move the smaller windows to

different positions.

Use the Configure pull-down menu to further customize your

environment. You can specify the editor you want to use, the tools

you want in your tools list, and the sessions you want included in the

Switch List, which works like the OS/2 Windows list. You can also

change the WorkFrame/2 background to a color or a bitmap, as well

as set the colors and fonts for the different listboxes.

The Preferences option of this pull-down lets you turn on or off the

WorkFrame/2 sound and animation features, and specify how you

want tools and monitor windows to appear. A monitor window

appears when you perform an action or invoke a tool, and shows all

messages, return codes, and other information generated by that

action. You can also specify that the window positions be saved

every time you end the WorkFrame/2 session.

If you want to set the window positions to always come up the same

way, regardless of where they were the last time you ended your

session, use the Save Settings option from the File pull-down. This

 Copyright IBM Corp. 1992, 1993  9



  

 

option also allows you to save your profile. The settings you save

are kept until you explicitly reset them.

Hints on Using Your Mouse

The WorkFrame/2 interface offers some features that are ideal for

mouse users. In most windows, you can double-click on an item to

perform actions. For example, double-click

� On a source file to invoke the editor.

� On an executable to run the program.

� On an object file within the LIB utility window to show details of

the object module.

You can use dragging to copy and delete files, or to copy the

characteristics of a project or tool to another project or tool. For

example, you can delete a file by dragging it to the Delete icon. To

do this:

1. Open a project list window from the Project Control window,

and the Deletion window from the File pull-down menu.

2. Highlight the file or files you want to delete from the project

window.

3. Point to the file with the mouse and press mouse button 2. The

pointer changes to an icon resembling a sheet or sheets of

paper.

4. While holding down the button, move the mouse icon to the

Deletion window. Notice that in areas to which the file cannot be

dragged, the icon changes in appearance to a prohibitory

symbol.

5. When the icon is over the Deletion window, release the button.

You can also change the size of a window by dragging its borders,

or move the window by dragging the title bar.
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 Basic Concepts

There are a few basic WorkFrame/2 concepts that you should

understand before you begin working with the product.

 Projects

Instead of working with individual files and directories, the

WorkFrame/2 product uses projects. A project consists of a

collection of related files within a directory and the attributes

associated with those files. These attributes include a set of options

for compiling, linking, making, debugging, and running your program,

as well as a language profile. You only need to specify these

attributes once for a project, although you can change them, and

they are shared by all the individual files in that project. For more

information on projects, see “Creating Projects” on page 13.

 Language Profiles

Each project you develop must have an associated language profile.

The language profile defines a number of things, including:

� The compiler, linker, debugger, and make utility to be used with

your project.

� The files (DLLs) that provide options for the above tools.

� The default argument string used when invoking the make and

debug tools.

� The include and library search paths.

Use the Language Profile Management option from the Tools

pull-down to create and modify your language profiles. The

WorkFrame/2 product provides a default language profile that you

can modify for use with most compilers, or use as a prototype to

create your own profile. The IBM C/C++ Tools product also provides

its own language profile.

To create your own language profile, highlight the Default language

profile in the Language Profile Management window, then click on

New. The New Language Profile window appears, with the values

  Getting Started 11



  

 

for the Default language profile indicated. You must change the

following fields:

File name

The name to give the file containing the language profile.

The file name must be unique. It will be given the

extension .PRF and placed in the WorkFrame/2 installation

directory.

Language name

The name used for the language profile in lists, headings,

and messages. This name should also be unique.

Language compiler and Language debugger

The commands that invoke your compiler and debugger,

respectively. The default names provided do not refer to

valid existing products.

Language eyecatcher

The name used to internally identify the language. The

name must be unique.

Depending on the tools you are using, you may also need to change:

Language extension

The extension your source files will have. This depends

on the language compiler you are using. The default is

.C for a C compiler.

Language linker and Language maker

The commands that invoke your linker and maker,

respectively. The default names provided refer to the

LINK386 linker and NMAKE utility (available in the IBM

Developer’s Toolkit). If you do not have these two

utilities, you must also change these commands.

Once you have made your changes, click on the OK button to create

your language profile. The profile will then appear in the Language

Profile Management window.
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 Creating Projects

To begin actual development using the WorkFrame/2 product, the

first thing you must do is create a project. Use the Project Control

option from the File pull-down to display the Project Control

window. This window lists the existing projects, and allows you to

display, change, or delete them, or create new projects.

You can create two types of projects: base and composite. A base

project is generally used to group the set of files used to build an

executable module or DLL. A composite project is simply a

collection of other base and/or composite projects that allow you to

build more complex applications involving multiple executable

modules or DLLs.

For example, you might have a base project to build an executable

module, and two others that build DLLs. You might then create a

composite project containing these three base projects. The

composite project would use the modules created by the base

projects to create another executable module or DLL.

When you create a base or composite project, you must first specify:

A project description

The name used for the project in headings, messages,

and list boxes. The project description must be unique.

A project file name

The name for the project control file. The file extension

.PRJ is appended to the name.

When you create a base project, you also specify a number of

attributes that are associated with the project until you specifically

change the project itself. These attributes include:

A project directory

The directory where the project files reside. A project can

have only one directory. However, the same directory

can be used for multiple projects.
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A target file

The file that you plan to create with the project, usually an

executable file or dynamic link library (DLL).

A make file

The name of the make file used to create the target file.

If the file does not exist, you can later create it using the

WorkFrame/2 Make File Creation utility.

A language profile

The name of an available language profile. See

“Language Profiles” on page 11 for more information on

language profiles.

A set of options

The compile, link, debug, make, and run options to be

used when creating the target file. If you use certain

options regularly, you can set them here and save them

with the project, so that they are always used. You can

also set or reset them later from the Options pull-down.

The pull-down allows you to save the new options with

the project, or to use them only for the current

WorkFrame/2 session.

When you create a composite project, you specify the individual base

or composite projects to be used, called subprojects. You also

indicate which of these subprojects will contain the final program to

be debugged and run.

One of the WorkFrame/2 features is that you can create several

projects with the same project directory and target file, and vary

other attributes to tailor each project to a different stage of the

program's development. For example, you can associate a different

set of options to each project to create a debugging version, a test

version, and a finished version of the same program.
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The WorkFrame/2 Development Cycle

This section presents an overview of how you use the WorkFrame/2

to develop an application.

Notes

� Before you begin creating applications, you should first decide

how your existing files and directories will map into WorkFrame/2

projects, both base and composite.

� To perform the steps outlined in this section, you must have a

compiler, linker, debugger, and make utility installed and in a

directory specified in the PATH variable of your CONFIG.SYS

file. You must also have a language profile that specifies each

of these tools.

1. The first step is to create a project. If the Project Control window

is not already displayed, select Project Control from the File

pull-down. Click on New from the Project Control window, and

specify the attributes you want to associate with the project. For

more information, see “Creating Projects” on page 13.

2. When you have specified the project attributes, click on OK in

the Create window. The new project name appears in the

Project Control window. Then click on Cancel to close the New

Project window.

3. To open or display your new project, select the project name and

then click on Open, or double-click on the project name. If the

project is a base project, a window appears with a list of the

project files. If the project is a composite project, the window

contains a list of the subprojects that make up the composite

project. The following steps assume the project is a base

project.

4. If your project already contains some files, you can proceed to

step 5 on page 16. If you want to create a new source file, click

on New from the project window. You are prompted for a file

name, and the editor is then invoked automatically. Once you

have saved and closed your file, click on Refresh to refresh the
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project window (the window is not automatically refreshed after

every action is completed).

5. Select the file or files in the base project window that you want to

perform actions on. Then use the Actions pull-down to create

your target file. You can select Build or Make to create the file

in one step, or use Compile and Link to compile and link

separately. A monitor window displays the messages and results

of the action.

Note:  The invocation of the Make action requires a make file. If

a make file does not exist for the project and you want to

create one, select Make File Creation from the Tools

pull-down. You can specify the actions you want the

make file to perform, and the compile and link options

you want used. If you do not specify any options here,

the make file utility uses the options associated with the

project.

6. Run your application by selecting Run from the Actions

pull-down, or by double-clicking on the executable file in the

project window.

7. Use Debug from the Actions pull-down to invoke the debugger

and debug your target file.

Note:  If your compiler or linker has options to generate debug

information, you must set them on to be able to debug your

program.

8. If the application is a tool, you can then use the Configure

pull-down to add it to the WorkFrame/2 Tools list, where you can

access it from a pull-down menu. You can also drag the project

from the Project Control window to the Tools list.

9. When the tool or application is no longer needed, you can delete

it from the Tools list, and then delete the project itself from the

Project Control window.
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 Sample Files

In the PRJ directory are two subdirectories of sample files (see

“WorkFrame/2 File Structure” on page 19). You can use these files

to create and develop projects as described in “The WorkFrame/2

Development Cycle” on page 15.

The first sample, PMSPY, is a 32-bit SAA C application that lets you

look at messages being received by a Presentation Manager*

application. To build the project, you need a C compiler and linker,

with a language profile that specifies these tools. The executable

module is also included. If you cannot build the project yourself, you

can still use the Add Tools pull-down to add the program to your

tools list.

The second sample, SAMPDLL, is a 16-bit C application designed to

demonstrate the WorkFrame/2 programming interfaces used to

create options DLLs for a language. The language DLL enables a

programming language to work more closely with the WorkFrame/2

product. The sample is based on the WorkFrame/2 default profile

DLL (DDE3DEFL.DLL). You can modify the source files of this

sample to create your own options DLLs.

  The WorkFrame/2 Development Cycle 17
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WorkFrame/2 File Structure

The subdirectory IBMWF (or the target directory you specified) is

created automatically by the installation program and contains all

other WorkFrame/2 subdirectories and files.

The WorkFrame/2 file structure is as follows:

──IBMWF
 ├──BIN
 │ ├──ADDTOOL.EXE
 │ ├──ADDUSER.EXE
 │ ├──LIB.EXE
 │ ├──WF.EXE
 │ └──WFENV.EXE
 ├──DDE3DEFL.PRF
 ├──DLL
 │ ├──DDE3DEFL.DLL
 │ ├──DDE3LIBT.DLL
 │ ├──DDE3LINK.DLL
 │ ├──DDE3MAKE.DLL
 │ ├──DDE3OPTS.DLL
 │ ├──DDE3PROF.DLL
 │ ├──DDE3RUN.DLL
 │ └──DDE3THNK.DLL
 ├──HELP
 │ ├──ADDUSER.HLP
 │ ├──DDE3CPRC.HLP
 │ ├──DDE3DEFL.HLP
 │ ├──DDE3LINK.HLP
 │ ├──DDE3PROF.HLP
 │ ├──DDE3RUN.HLP
 │ ├──DDE3WF.HLP
 │ └──DDE3WF.INF
 ├──IBMSDATA.INI
 ├──IBMWF.INI
 ├──PRJ
 │ ├──SAMPDLL
 │ └──PMSPY
 ├──READ.ME
 ├──SHRED1.BMP
 ├──SHRED2.BMP
 ├──SHRED3.BMP
 ├──SHRED4.BMP
 └──SHRED5.BMP
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Notes:

1. The SAMPDLL and PMSPY directories contain a number of files

you can use to create the SAMPDLL and PMSPY projects,

respectively.

2. If you install the IBM C/C++ Tools product at a later time, that

installation program will add a number of files to the file structure

shown.
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